
Help for ircle
==============

This is ircle, a Macintosh-based, windowed user interface to the Internet Relay Chat (IRC) network. 

This window contains:
0. Brief Overview on IRC
1. ircle Basics and Windows
2. IRC Commands and ircle Menus
3. Hints & Advice
4. General notes, Copyright Notice

------------------------
0. Brief Overview on IRC
------------------------
(If you know IRC, skip this section)
IRC is a multi-user online chatting system. It allows users to talk to other users all around the world via 
the Internet. This is done by connecting a 'client' program (such as this one) to a 'server'. You need a 
connection to any network connected to the Internet and running TCP/IP, and the MacTCP network 
driver. You have to find out your preferred server (usually the nearest) and enter this into the 
Preferences dialog. The port number used by IRC servers is usually 6667.
On IRC, users are identified by nicknames of their own choice. Nicknames may be at most 9 characters
long.    The nickname is set via preferences or the NICK command (s.b.) If you choose a nickname 
already in use, you have to set a different nick. Some users have registered their nicknames with the 
NickServ database. If you get a message from NickServ that your nick is in use, please choose another.
Communication on IRC is done via Channels and Private Messages. Channels have names starting with 
# and usually up to 12 characters long. You can see a list of the channels currently in use via the /LIST 
command. As soon as you join a channel with the /JOIN command, everything you type is sent to that 
channel and seen by all other users on that channel. You will see what the others type, respectively.

---------------------------
1. ircle Basics and Windows
---------------------------
ircle has a user interface similar to the traditional text-oriented IRC clients. If you know IRC, you will 
find it familiar. At the bottom of the screen is the input line in an own small window which also carries a
line of status information. Everything you type will appear in the input line. When you press Return, the
line gets sent to the current channel or, if it contains a command, that command is processed. A line is 
considered command if it starts with a '/' (slash). You can change this character with the /CMDCHAR 
command. See Section 2 on commands.
You connect to the server via Open conection in the File menu. When the connection to the server is 
established, the main message window will appear. This window has your nickname in the title bar. 
As soon as you join a channel, a channel window will appear with the channel name as its title. All 
communication done in that channel will appear in that window. If you close this window, you leave the
channel.
Querying a user (s.b.) will open a user window. All private messages from and to that user will appear 
in this window.
You can switch between windows using the mouse or Command-, (comma) key. The destination of text 
that you type is always determined by the frontmost window, i.e. the text goes to the channel or user 
whose name is the frontmost window's title.
The number of windows open at a time is limited only by your computer's memory and your capability 
of listening at many sources at a time :-)
All messages not coming from or related to a channel or queried user will appear in the main message 
window. That can include long lists from certain commands. You can skip these by pressing Command-.
(dot).

-------------------------------
2. IRC Commands and ircle Menus
-------------------------------
Traditionally, IRC is controlled by typing commands. A line starting with a slash is considered a 
command. ircle has implemented this behaviour instead of a mouse-driven environment for simplicity 



and user-interface compatibility to other IRC clients. Certain frequently used commands can be 
reached via menus. These, however, do just paste the commands into the input line and thus are 
shortcuts for typing the commands.
The File menu has items for opening a connection, closing the topmost window (this will leave a 
channel), opening/closing a logfile and setting Preferences and the Quit command.
The Edit menu has the Copy and Paste items. Text in a window can be selected and copied, then 
pasted into the input line.
The Commands menus contain selected IRC commands. They get just pasted into the input line and 
are shortcut for convenience.
The Shortcuts menu provides a means for user-defined shortcuts. They can be defined in a dialog box 
and called via Command-0 through 9. Note that new settings work only after closing the dialog box.
The Font menu lets you set your preferred font and size. This will affect the currently active window 
and all new windows opened afterwards. It also gets stored in the Preferences file.
The Windows menu contains the titles fo the active windows for direct selection.

Preferences settings
--------------------
Preferences settings are stored in a preferences file. You can start ircle with particular settings by 
double-clicking on the preferences file. Otherwise, you will be prompted for a new file to store the 
settings in.
The settings are:
Server: The server you want to connect to. This has to be a numeric IP address or a full host.domain 
name.
Port: Usually 6667, when in doubt check with your server administrator.
Nickname: The nickname you want to start with.
Mail address: You should specify your login name or mail address on a fully qualified (with domain) 
machine. Some servers check if this address exists (not tested by me).
Real name: Your real name (or whatever evil thing you want to look like your real name)
Auto-Exec: You can specify a sequence of commands that get executed on startup. These are prefixed 
by / and separated by ; 
(example: /join #myChannel;/topic #myChannel I'm on irc again!)
Notifications: when messages appear in an inactive window, or in any window while ircle is running in 
the background, you will get alerted by a sound and/or blinking menu bar item, as you can select by 
checking these boxes.

Description of IRC Commands
---------------------------
The following commands are currently available: (x) = untested. 
* = operator command, untested and opers should know them anyway :-)
/admin nick 
              server            Shows administrative info
/away message            Marks you as being away (no message = not away)
/bye message              Displays message and quits IRC
/broadcast message Sends a message to all of your windows
/channel channel      Join a channel
/cmdchar c                  Changes the command-prefix (default /) to the given character
/connect                      * Connect two servers
/ctcp target command    Issues a CTCP command. Do /ctcp target clientinfo for more info.
/date                            display date/time (x)
/dcc command nick    Issues a DCC command (explained below).
/die                              * Shut down a server
/exit message            =/bye
/hash                            * Reconfigure a server
/host                            (x)
/ignore pattern        ignore messages from nick!user@host (may contain wildcards)
                +pattern      ignore and give the ignored a notice
                -pattern      removes a pattern from the ignore list
/info                            gives info about server
/invite nick channel invites nick to channel
/join channel            =/channel
/kick channel nick kicks nick from channel



/kill nick                  * kicks nick out of IRC
/leave channel          leave a channel
/links                          show server connections
/list                            list channels
            -min n              list only channels with minimum of n users
            -max n                                                    ...    maximum of n users
            -public            list only public channels
            -private                      ... private channels
            -local                          ... local channels
            -global                        ... global channels
            -topic                          ... channels with topic
/lusers                        display statistics
/me action                  sends an action description
/mode channel par    set channel mode
                            +p      private channel
                            +s      secret channel
                            +i      invite-only channel
                            +m      moderated channel
                            +n      no messages from outside channel
                            +t      only channel op may set topic
                            +l n channel may hold at most n users
                +v nick        let nick speak on moderated channel
                +b nick        ban nick
                +k key          set channel password
                +o nick        nick becomes channel op
                            -x      removes flag x, where x is one of the above
/mode nick par          set user mode
                            +i      invisible user
                            +s      receive server notices
                            +w      receive wallops
/motd                            show message-of-the-day
/msg nick message    Sends a private message
/names channel          List users on channel
/nick newnick            Change your nickname
/note                            (x)
/notice                        (almost) like /msg
/notify nick              Adds nick to notification list (show each signon/off)
                -nick            removes nick from notification list
/oper                            become operator *
/part channel            =/leave
/query nick                open window for private messages to nick
/quit message            =/bye
/rehash                        * Reconfigure a server
/restart                      * Restart a server
/server srvadr          Switch to a different server
/signoff message      =/bye
/squit                          * Remove a link between servers
/stats                          Statistical info
/summon user@host    Invites user@host to IRC (host must be running a server)
/time                            =/date
/topic channel text Set a channel topic
/trace                          (x)
/type                            Type a text file to the current channel
/users                          (x)
/version                      Show server version
/wallops message      Message to all operators (deprecated)
/who channel              List people on channel
/whois nick                Give information about user
/whowas nick              Give information about user having gone

Valid commands for /dcc are:



chat    - requests CHAT connection for nick or answers such a request
send - send a file; tsend - send a text file
get - receive a file (to be answered to a SEND request); tget - receive a text file
list - list all DCC connections.

-----------------
3. Hints & Advice
-----------------
More information on IRC commands can be found in the 'ircle Users manual' and 'IRC Advice' files and 
probably in the help files for the IRCII client (but note that IRCII has a number of commands for 
programmability that ircle has not).
When selecting a non-proportional font keep in mind that IRC was originally designed for text terminals
and some commands and messages assume a fixed-size screen. That may make output look strange in
some situations.
This client uses the ISO Latin-1 8-bit character set and converts Macintosh special characters to this 
code. (If you find conversion errors let me know!) Some characters can not be converted and will be 
mapped to nonsensical characters. This also holds for DCC tsend/tget which are text-mode versions of 
send/get.
New users should check the file 'IRC Advice'.

----------------------------------
4. General notes, Copyright Notice
----------------------------------
This program was written by Olaf Titz (s_titz@ira.uka.de), July 1992-July 1993. You may use, copy and 
distribute it under the terms and conditions of the GNU General Public License, see the file COPYING 
that should have accompanied this program. Be sure to include the file COPYING when distributing this 
program.

Copyright (c) 1992,93 Olaf Titz.
Some parts of this program written by Peter N. Lewis, (C) 1992.
Written and compiled using THINK Pascal 2.0.1, thus Portions Copyright (C) 1988 Symantec Corp.

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 

System requirements: any Mac with System version greater 6.0 and the MacTCP driver.

This client is to fit version 2.7 and 2.8 servers. All commands and features obsoleted by 2.7 are taken 
out (as should be all obsolete servers by now).
Not all commands have been tested; there may still be some bugs, feel free to report them to me (or 
the alt.irc newsgroup). 

I called this ircle with a German -le suffix and spelled uncapitalized because it is rather small, and I did 
not put too much work into it. There are certainly IRC clients with much more functionality around, but 
this is runs in Mac windows, and after all, it seems to work.
Have fun!


